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Welcome
The First Steps Guide will provide you with the information you need to properly install and configure 
the TeleMate Call Accounting product. The guide also briefly describes the various components of 
TeleMate and how you can use them to make TeleMate work effectively for your company.
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General Information

System Requirements
• Server OS: Any Windows Server OS from 2003 SP2 to 2008 R2
• Desktop OS: Any Windows Desktop OS from XP SP2 to Windows 7
• Web Interface: Internet Explorer 6.0, Firefox 3.0, Opera 9.0, Google Chrome

NOTE: The real-time monitors will not work in IE 6.0.

Processor, memory, and hard drive requirements vary widely depending on the volume of call data you 
need to process and report on. For disk space, a good rule of thumb would be about 2GB per million call 
records, so if your entire organization averages 100,000 calls per month and you want to keep up to 5 
years of calls, that would add up to about 6 million calls and 12GB of disk space. For most installations, a 
normal desktop PC with 2GB of memory will be sufficient, but the larger the database, the more 
resources SQL Server will need to maintain good performance.

TeleMate is supported on 32-bit and 64-bit Windows operating systems, Terminal Servers, Citrix servers, 
and virtual servers. However, if you choose to install TeleMate on a virtual server, we recommend that 
you move the TeleMate database to a stand-alone SQL Server installation that is not running in a virtual 
instance. Virtualization can add a lot of overhead to disk I/O, and that can severely impact SQL Server 
performance.

For more detailed information, please contact your product vendor's sales department.

Additional Recommendations
• To improve reliability, an uninterrupted power supply (UPS) and a RAID drive configuration
• To handle larger call volumes, SQL Server Standard or Enterprise Edition (TeleMate installs SQL 

Server 2005 Express Edition)
• To get faster technical support, an Internet connection or a modem with Symantec pcAnywhere
• To protect against hardware failure, a reliable backup system that can handle incremental and 

full backups of SQL Server databases and transaction logs
• To print large reports, a high-output laser printer with extra-capacity paper feeder

Product Registration and Licensing
If you have purchased the product and need to license it, you must contact registration services:

• Phone: 678-589-7140
• E-mail: registration@telemate.net
• Web Site: http://www.telemate.net/services/support/license.php

The web site provides forms for you to:
• License the product for the first time
• Relicense the product due to a reinstallation of the software
• Relicense the product to add additional features
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Contacting TeleMate.Net Software
If you have any questions during or after the installation/configuration process, please use the following 
information to contact us.

Address TeleMate.Net Software
5555 Triangle Parkway Suite 150
Norcross, GA 30092

Web http://www.telemate.net/
Main Number +1.678.589.7100
Fax Number +1.678.589.7110
Sales and Product Information Phone: +1.678.589.7100

E-mail: sales@telemate.net
Registration Services Phone: +1.678.589.7140

E-mail: registration@telemate.net
Technical Support Phone: +1.678.589.7120

E-mail: support@telemate.net
Customer Training Phone: +1.678.589.7100

Customer Training Workshops
TeleMate offers comprehensive classroom training.  Extensive hands-on exercises, classroom 
participation, and optional individual lab help to accelerate the learning curve, which means a greater 
and faster return on your investment.

Training is held at our training facility in Norcross, Georgia. We also offer on-site setup and training. For 
more information about our Customer Training Workshops, visit our Web site at 
http://www.telemate.net/ or call 678-589-7100.
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Installing TeleMate

Typical Install
You can easily install the product with just a few clicks of your mouse. This type of install will create a 
new TeleMate primary server, so make sure you’ve checked the system requirements and are ready to 
proceed. We strongly recommend that you close any applications before you begin the installation 
process.

Launching the Install
Unless AutoRun is disabled, all of the supported Windows operating systems will automatically launch 
the install when you insert the CD. If it does not start automatically, follow the steps below:

1. Click the Start button on the Windows taskbar and select Run.
2. In the box provided, type X:\SETUP.EXE, where "X" is your CD-ROM drive.
3. Click OK to launch the TeleMate install.
4. If "Run" is not available on your Windows Start Menu, you may also open "My Computer", 

double-click your CD-ROM drive, and then double-click "Setup.exe".
Note: If you’re installing on Windows XP with SP2, you may be asked to update the Windows Installer, 
which will require you to reboot and restart the installation.

Performing the Typical installation
1. Click Next to skip past the Welcome screen.
2. On the License Agreement screen, read the agreement and click Accept.
3. Choose a destination folder for TeleMate. The default folder is "C:\TeleMate Software", but you 

can install it anywhere you wish. By default, the TeleMate database is stored somewhere under 
the destination folder, so be sure to choose a drive with sufficient free disk space.

4. Click Next to begin the install.
Note: The installer will install Microsoft SQL Server 2005 Express and all of its pre-requisites. Each brings 
up its own progress windows. Please do not cancel any of them.

Installing TeleMate Client Stations
If you want to administer the TeleMate server remotely without using remote access software like 
Remote Desktop or VNC, you will need to install a TeleMate client station. TeleMate's client install will 
install the TeleMate software to any PC on the same network and configure it to connect to the 
TeleMate database. You can install as many clients as you like, but your license will limit the number of 
"concurrent" connections to the database.

If you only wish to allow other users in your organization remote access to TeleMate's directory or 
reports, we recommend that you set up the TeleMate web interface instead. It must be licensed 
separately, but it does not require you to install anything on the clients, and it offers a cleaner interface 
that is easier to learn and use.

NOTE: Before you can install TeleMate client stations, you must have TeleMate add a network share to 
the TeleMate server. If you add this share manually, the TeleMate license file will not be updated to 
allow clients to read it, and the clients will not run.
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Configuring the Network Share (from the server)

1. Log into the server as an administrator.
2. Double-click the TeleMate icon on your desktop to launch TeleMate.

Note: On Windows Vista, 7, or 2008 Server, you need to right-click the icon and select “Run as 
Administrator”.

3. Open the “Tools” menu in TeleMate, and select “Add Network Share”.
4. Click “Yes” to create a share.
5. Click “OK” on the confirmation screen.

Installing the Client Station (from the client)
1. Log into the client as an administrator.
2. Open “My Computer” or “Windows Explorer” (not Internet Explorer).
3. In the address bar, type "\\<TeleMate_Server>\Telemate\Client".
4. Run Setup.exe.
5. On the Welcome screen, click next once you are ready to proceed.
6. Choose a destination folder to install the client to, and press “Next”.
7. Press “Finish” when the install is done.

NOTE: Do not map the TeleMate share to a drive letter when installing the client. The client will only be 
able to read the TeleMate license file if it is pointing to the full UNC path that was configured on the 
TeleMate server.

Terminal Server Installation
As of release 5.2, TeleMate supports the use of Terminal Server (and Citrix), which allows multiple users 
to run TeleMate simultaneously from a single installation.  Because the TeleMate client is run entirely on 
the server, administrators no longer have to install or update the client software on every user's 
machine.  It is important to note that installing TeleMate into a Terminal Server environment requires a 
bit more planning and a few extra steps, so please read this installation guide carefully. 

Choosing the Server's Role
The first step you must take is to decide what role the Terminal Server should play.  It can be the 
primary TeleMate server (installed from the TeleMate CD) or it can be a client access station (installed 
from a network share created on the primary TeleMate server).  By default, the primary server runs: the 
database server that manages the TeleMate databases, collection and processing for all CDR logs for all 
data sources, scheduled reports and other maintenance tasks, and the web server for customers using 
the web interface. Depending on the size of the TeleMate installation, this may require a large amount 
of your Terminal Server's memory, CPU time, and disk I/O time.  If your Terminal Server is already being 
used to serve other applications, or if you plan to have a lot of users run the TeleMate client 
simultaneously, then you should consider installing the TeleMate primary server on another stand-alone 
server, and then run the TeleMate client install on the Terminal Server.

Launching the Install
Whether you are installing the full TeleMate product or just the TeleMate client, our install is no 
different on Terminal Server than it is on any other server.  However, Terminal Server must be put into 
install mode before you can install any application.  Here are the steps you should take to accomplish 
that:
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1. Log into the Terminal Server console as an Administrator.
2. Open the Control Panel and go to "Add/Remove Programs".
3. Select the "Add New Programs" icon on the left side of the window.
4. Select the "CD or Floppy" button to open Terminal Server's install wizard.
5. If you are installing the TeleMate primary server from our CD, insert the CD and press Next. 

Otherwise, just press “Next”.
6. If you are installing a TeleMate client station, enter the UNC path to the TeleMate client install 

(i.e. \\<TeleMate_Server>\TeleMate\Client\Setup.exe). Otherwise, make sure Terminal Server 
found the SETUP.EXE on the TeleMate CD. Press “Next” when you are ready to start.

7. At this point the Terminal Server will be in install mode, and the install will be launched for you. 
The Terminal Server install wizard will wait in the background for you to complete the install.

8. Refer to our Typical Installation instructions to find out how to complete the TeleMate install.
9. Wait for InstallShield to shut down, and then press “Next” on the Terminal Server install wizard.
10. Press the Finish button on the Terminal Server installation wizard.  If the TeleMate install asked 

you to reboot before it shut down, you must reboot after finishing the install wizard.

Running TeleMate on a Terminal Server
If you installed the TeleMate client onto Terminal Server, there are no special concerns. Because the 
client does not have to collect or process data, it will behave like any other client. However, if you 
installed the primary TeleMate server onto a Terminal Server, then the server's console login will be 
treated as the “main processing station” and each remote login will be treated as a separate client 
station.  This causes a few restrictions that you should be aware of: 

1. When you create your first data source (which represents a PBX or phone system) in TeleMate, 
it must configure the main processing station, which means registering and starting the 
TeleMate services.  This means that you must be logged into the server’s console (not a remote 
login), and the login will need Administrator privileges.

2. You must also be logged into the console as an Administrator to configure some of the TeleMate 
collection methods, which require direct access to certain devices (i.e. COM ports and modems) 
that are not generally available through Remote Desktop.

3. You may use a remote login for everything else you need to accomplish in TeleMate, and that 
login does not require Administrator privileges.

4. TeleMate has a useful utility to help Administrators manage the TeleMate services.  This service 
manager normally only runs on the processing station, but for convenience we allow it to run 
when a Terminal Server Administrator is logged in remotely.
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Getting Started with TeleMate

Initial Setup
As soon as you complete the installation of the primary TeleMate server, TeleMate will be launched 
automatically, and you will be prompted for some initial setup information:

1. First you will be asked to provide contact information and a serial number. Use the serial 
number on your CD jacket for this purpose.

2. Next you will be asked whether you wish to evaluate the product or license the product. (Some 
OEM versions of TeleMate are licensed automatically and will not ask you this.) Evaluating the 
product allows you to use the product for 30 days. Failure to license the product within the 
evaluation period will disable access to TeleMate until you license it.

3. If you choose to evaluate TeleMate, you have the option to process and report on your own 
data (which requires additional configuration effort), or to use our provided Demo database that 
contains sample directory information and call data.

4. The first time you run TeleMate with the “main” database selected, it will prompt you to create 
your first voice data source so you can begin configuring the product to work with your call data.

Note: The File menu in TeleMate has a command to switch between the demo database (sample 
data/configuration) and the main database (your data/configuration). This makes it easy to examine the 
sample data and configuration before you start configuring TeleMate for your organization.

Previewing TeleMate Reports
Before you configure TeleMate, we recommend that you take a look at our sample reports. This will give 
you a better idea of the various ways in which TeleMate can present your data to you, which may affect 
how you configure your data sources.

1. In either the “Go” menu or the “Go” toolbar, select “Report”.
2. Open the “View” menu and make sure “Report Preview” has a check mark next to it. If it 

doesn't, select it.
3. On the right side of the main view, select the “Preview” tab.
4. On the left side of the main view, browse through either the “Category” report listing or the 

“Alpha” report listing.
5. Each time you select a report template, the TeleMate Report Engine will run that report against 

the sample data in the demo database and display the results.
6. Switch to the “Properties” tab to see the distribution options and filters available. (Each report 

template may have different filters available.)
7. Switch to the “Options” tab to see additional report formatting options that affect the report 

output. (Each report template may have different options available.)
Note: Changing report options and filters will not affect the report preview. To see how they affect a 
report, switch to the demo database, change the options, and select “Run to Screen” or “Run to 
Destination”.

Licensing your Product
To permanently license your product (or to update your license), please follow these steps:

1. Ensure that you are working in TeleMate’s main database.  If you are working in the demo 
database, open the File menu and select “Use Main Database”.

2. Open the Tools menu and select “License Update”.
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3. To register via email:

a. If you have configured the SMTP options TeleMate needs to send email, select “Send 
Email”.

b. Otherwise, copy and paste the “Code Entry Number”, the “Computer ID”, and the 
“Serial Number” into an email and send them to registration@telemate.net. Be sure to 
include your company name and some form of contact information.

c. Wait for a reply containing the two codes you need to update your license.
4. To register via the web:

a. Go to http://www.telemate.net/services/support/license.php in your web browser.
b. Fill in the form and submit it.
c. Wait for an email containing the two codes you need to update your license.

5. To register via phone:
a. Call registration services at +1.678.589.7140.

Moving the Database
The default TeleMate install creates a SQL Server 2005 Express instance named "TELEMATE" on the local 
machine. If you install TeleMate on a machine named "TM", the full SQL Server instance name is 
"TM\TELEMATE". We assign our own password for the "sa" (system administrator) account, and all 
TeleMate clients and services use that account to access the TeleMate database. The default database 
name is "CATS" (for Call Accounting Tele-management System). The default location for the database 
files is C:\TeleMate Software\Data (assuming you installed TeleMate to C:\TeleMate Software). Many of 
our customers prefer to move the TeleMate database to an existing SQL Server (or cluster) that is 
already maintained and backed up by their IT department, so we tried to make this easy to do. The 
current release of TeleMate supports SQL Server 2000, 2005, and 2008.

If you select the "Move Database" command under TeleMate's File menu, you will be prompted with 
this window:
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To move the TeleMate database, simply enter the new information into the dialog and press OK. This 
command leaves the original copy of the TeleMate there, so you can also use this command to create a 
backup of the TeleMate database. When connecting to a different server, keep in mind that the login 
you use must have sufficient privileges to create a new database. The TeleMate clients and services 
don't require this privilege, but the move command does. If your SQL Server admin doesn't want to 
grant you this level of access, there are a few simple ways around this:

1. The SQL admin can run the "Move Database" command using his Windows domain account and 
the "Windows Authentication" option. When the move is done, he can log back out and grant 
your domain account db_owner access to the new TeleMate database.

2. The SQL admin can run the "Move Database" command using your Windows domain account, 
but provide a SQL login with the necessary privileges. When the move is done, he can use the 
"Select Database" command to change the login used by TeleMate clients and services. 

3. The SQL admin can manually copy TeleMate’s database to the new server. When the copy is 
done, the "Select Database" command can be used to point TeleMate to the new database. 

NOTE: TeleMate does not delete the existing database after a move because it is not always easy to 
verify whether everything copied successfully. We strongly recommend that you keep your old database 
active until you confirm that TeleMate is running smoothly with the new copy.
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TeleMate User Interface Components
The TeleMate user interface is made up of various menu and tool bars, and a main view that is used to 
work in any of the six TeleMate components: Report, Directory, Voice, Alarms, Scheduler, and User 
Manager. There is also a separate service manager for managing and monitoring background services 
for collection, processing, scheduling, and the web server. TeleMate’s Web Interface will be explained 
later.

The Menu and Tool Bars
The toolbars, the component bar, and the output window are all dockable. This means that they can be 
attached to (i.e. docked) or removed (i.e. undocked) from the main window. To dock/undock a 
component, click+drag or double-click the part of the component that looks like two small speed bumps. 
Use the “View” menu to open or close these components. Settings regarding which components are 
open and/or docked are saved when you close TeleMate.

The Voice Component
To open any component, simply select that component in the component bar or in the “Go” menu. 
Before you can do anything with your own data in TeleMate, you must create and configure Voice data 
sources to process raw data into the database.
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Creating a Voice Data Source
A Voice data source represents a single source of CDR (Call Detail Record) logs. CDR logs generally come 
from a phone system (i.e. PBX) or a service provider like Verizon or AT&T. You must complete several 
configuration steps before you can process your own CDR logs. Some steps are mandatory for all data 
sources, but some steps will depend on how data appears in your CDR log files. There are several 
optional features that you may wish to configure to get the most out of TeleMate, but the purpose of 
this guide is to get you started.

The first time you open the Voice component in TeleMate, the data source wizard will prompt you to 
create your first voice data source. If you have already created one, you will be asked to select an 
existing data source to work with or to create a new one (if your license allows you to create more). The 
30-day evaluation license only allows you to create one data source.

The data source wizard will ask to provide the following information:
• Name (required), ID (optional), and Description (optional)
• CDR Time Zone (customers may have multiple data sources in multiple time zones)

Note: If one CDR log file may contain records from multiple time zones, this is the “default” time 
zone for the data source. These time zone settings can be overridden per trunk group.

• Rate Center (source country and city code, required for accurate call processing)
Note: These settings can also be overridden per trunk group
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• Provided Tariffs (includes a table of country codes, city codes, the local dialing area for your rate 

center, and standard rates from AT&T, MCI, and Sprint)
Note: TeleMate attempts to download tariff updates from our web site automatically, but you 
can also request them to be sent to you on a CD

Configuring Collection
As soon as you complete the data source wizard, you will be asked if you want to configure collection. 
Collection is the operation that gathers the CDR log records/files for TeleMate to process. If you already 
have a method configured to collect this data for you, then you must tell TeleMate where to find the 
data in this step.

Follow these steps to configure collection for your data source:
1. Open the Voice component and select the correct data source.
2. When TeleMate asks you to set up collection, select “Yes”.
3. If the data source is already open and you selected “No” when asked, open the “DataSource” 

menu and select “Properties”. TeleMate will ask you to set up collection again.
4. Read the text on the first page of the collection wizard and select ”Next”.
5. If you plan to have TeleMate collect the CDR records for you, specify the folder you want 

TeleMate to save the log files to. If not, specify the folder you want TeleMate to read the log 
files from.

6. Specify whether you want TeleMate’s processing engine to leave the log files alone, delete 
them, or back them up (move them to a different folder) when it has finished processing them.
Note: Some collection methods create one monolithic file, and others create hundreds of small 
files. In this case, we recommend that you back them up and check the “Split/merge” checkbox.

7. The next screen will ask you which collection method you wish to use:
a. Direct Collection utilizes a serial cable connected from a PBX directly to a COM port on 

the TeleMate server. If you select this method, you will need to specify the serial 
connection properties (i.e. serial port, baud rate, data bits, parity, stop bits, and flow 
control).

b. Remote Polling utilizes a modem to call and collect data from a supported buffer box 
(aka CSD or Call Storage Device).

c. Customer Supplied File lets you use an external method to collect calls, and simply asks 
you where and how to read the log files. If you use the TeleMate Collector Pro to collect 
logs, have a CSD (Call Storage Device) pushing data to your server, or have a service 
provider sending you log files, you should use this collection method.

d. External Database uses a custom stored procedure to collect call records from a 
database. The default procedure collects calls from a Cisco Call Manager database, but it 
can be customized to collect from other databases.

TeleMate Collector Pro
TeleMate also offers a stand-alone product for collecting logs. Not only does it support several 
additional collection methods (RSP, syslog, telnet, FTP, scripted), but it also supports additional options 
and features for each method, including relaying data securely from remote locations to a central 
TeleMate location and generating alerts when no data is collected during certain time periods.

Configuring Processing Options
Before you can process any collected CDR logs, you must configure a CDR layout for your data source. A 
CDR layout tells TeleMate’s processing engine how to recognize what each CDR log record is (i.e. record 
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X is an incoming call, record Y is an internal call, record Z has no useful information in it, or records 
A+B+C+D need to be linked together), what values of interest each record contains, and how to convert 
those values into call records in TeleMate’s database.

TeleMate supports hundreds of phone systems, each with several different versions and options that 
can cause the CDR log record format to change. To further complicate things, two customers with the 
exact same format often decide that they wish to pick up different types of calls in different ways. To 
ensure that TeleMate can always meet our customer’s needs, we chose to tackle this problem by 
creating a very flexible mechanism for defining custom CDR layouts to parse anything the PBX vendors 
can come up with. So far we have never encountered a CDR log file that we couldn’t process.

These instructions are meant to be a guideline. They will guide you through the basic steps of selecting a 
CDR Layout. However, there may be places that you have questions or do not understand which settings 
you should use. If you need help configuring your phone system to generate/transmit the CDR logs, 
please contact your PBX administrator or vendor. If you need help configuring your CDR layout in 
TeleMate, please contact TeleMate Technical Support at 678-589-7120.

CDR Layout Wizard
After you finish the collection wizard, or if you open a data source that has no CDR layout selected, you 
will be asked if you want to choose a CDR Layout. If you select “Yes”, the CDR Layout Wizard will start:

1. On the Information screen, read the information and select “Next”. 
2. Select your PBX manufacturer from the list, select one of the models that appear in the list 

below it, and select “Next”.
3. Select the “…” button and specify the path to a CDR log file collected from your phone system. 
4. Enter the number of records you want to be run through TeleMate’s CDR Layout Test, and select 

“Next”. 
5. When the test has finished running, look at the number of records processed, and select the 

“View Test Results” button to see how well the layout matched your CDR records.
6. If everything is being picked up correctly, or it seems close, check the “Select To Make Current 

CDR Layout as Default” box and select “Finish”.
7. If nothing is being picked up correctly, back up and try a different model until you find a layout 

that closely matches your data.

Manually Selecting and Testing a CDR Layout
If you choose not to use the wizard, or if you need to change the selected CDR layout:, . 

1. Open TeleMate’s Voice component.
2. On the Voice menu, select “CDR Layout”.
3. Browse the list of CDR layouts, right-click on it, and select “Test Layout…” 
4. Press the “…” button, specify the path to a CDR log file, and press “OK”.
5. The test will run, and the test results will be opened in Wordpad. If that was not the current 

layout for this data source, you will be asked if you wish to make it the current layout after you 
close Wordpad.

Note: If you need to create or modify a CDR layout, please see “Setting up a Custom CDR Layout”.
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Customizing a CDR Layout
Creating a new layout from scratch can get extremely complex, and it is beyond the scope of this 
document. However, with some general information, some customers should be able to figure out how 
to make minor changes to an existing CDR layout. Before we start, it is important to point out that the 
core of every CDR layout is its set of record types. Before the processing engine can parse (or read) any 
CDR record, it needs to know what type of record it is. Most phone systems generate several different 
types of CDR records, and each type needs to be handled in a different way.

Record Type Tests

It will help if you pretend that the processing engine is blind until you tell it what to look for. You do that 
by creating record types and creating a set of tests for each type. If any CDR record passes every test 
defined for a specific record type, the engine says “Aha, I know what this record is!” If a record doesn’t 
pass the tests for any record type, that record is ignored and an error is displayed in the CDR Layout Test 
output (to let you know that you missed a record type). A “Test Priority” value lets you choose which 
tests should to run first, which helps when different record types look very similar.

Record Type Fields

Once the processing engine knows what type a record is, you need to tell the engine what to do with it. 
Should it create an outgoing call from this record? If so, where in the record should it look for the 
important fields (i.e. date, time, duration, extension, phone number, and trunk)? What format will the 
date, time, and duration records appear in? HHMMSS is very different from SSSSSS. Are there multiple 
consecutive records needed to generate a single call, or perhaps even multiple non-consecutive 
records? (Non-consecutive records require an ID field so the engine can link them together.) You tell the 
engine everyall to do this by specifying the record type options and record type fields.

Fixed Layouts

In a fixed layout, each field always starts and ends at fixed character positions in a record.  The records 
may look like this:

----+----1----+----2----+----3----+----4----+----5-- (1 = 10, 2 = 20, etc.)
2009-10-26 17:54:01 O 00165 4113  6371               97068754737
2009-10-26 17:54:02 I 00017 3944  5784        205784 4046469419

In this case, the call end date always starts at position 1, the end time at position 12, the call direction (O 
for outgoing, I for incoming) at position 21, the trunk at position 23, the extension at position 29, and so 
on. A simple layout like this would have two record types: one for outgoing calls with a test for O at 
position 21, and one for incoming calls with a test for I at position 21. For both, the date format would 
be YYYY-MM-DD, the time format HH:MM:SS, and the duration format SSSSS.
Note: Many phone systems do not specify the call direction. In that case, you might test for the phone 
number to start with the access code ‘9’ for outgoing (assuming you dial 9 to get an outside line). The 
tests needed are different for every phone system.

Delimited Layouts

In a delimited layout, fields are separated by a delimiter like a comma or a semi-colon, and they are not 
evenly spaced. The records may look like this:
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1-------------------2-3---4----5----678----------
2009-10-26 17:54:01,O,165,4113,6371,,,17068754737
1-------------------2-3--4----5----67------8---------
2009-10-26 17:54:02,I,17,3944,5784,,205784,4046469419

Because field locations are not in fixed character positions, TeleMate changes the definition of 
“position” to mean field position and “length” to mean offset. For the delimited layout above, the phone 
number (for outgoing) and ANI (for incoming) field is always in position 8, regardless of what character 
position it starts at. This layout would still have two record types, but the direction tests would be at 
position 2 instead of position 21. The call end time would be at position 1 with an offset of 12.

Advanced Options

There are several advanced options that are beyond the scope of this document. If you need help 
configuring your CDR layout, please contact TeleMate Technical Support at 678-589-7120.

Additional Processing Options
Once you have selected a CDR layout that picks up your calls correctly, there are several more 
configuration options you may need to set up before you process calls for the first time. Whether you 
need to configure these options depends on how the raw data looks immediately after it has been 
parsed by the CDR layout and on how you want to see it. These options include:

1. Access codes – If you dial ‘8’ to get an outside line, and the CDR includes the 8 in the phone 
number, TeleMate needs to know to strip it before processing the phone number.

2. Local area codes – If your local dialing area includes more than one area code, and you’re not 
using a provided tariff for local call determination, you need to specify your local area codes.

3. Custom call processing – Some calls require very special handling. For instance, you may need 
to drop calls made to/from Ombudsmen numbers. Or your PBX may route numbers starting 
with ‘5’ to/through an office in another country, requiring dialing prefix substitution.

4. Trunk groups – Trunks can be assigned to groups, and the grouping determines which costing 
method gets applied to each call.

5. Account Codes – Some phone systems log account numbers, which you can pick up in a CDR 
layout to help you assign call costs back to employees or clients. You can group those numbers 
by account codes and apply different markups to the call cost for each group.

6. Costing methods – Costing methods don’t rate calls (tariffs do that). Costing methods specify 
how to parse the phone number to determine location and which tariff to apply.

a. Outgoing – Lets you to specify call limits, dialing prefixes for local/national/intl calls, 
special numbers (i.e. emergency, toll-free, directory assistance), as well as tariffs and 
markups to apply to outgoing or tandem local/national/intl calls.

b. Incoming – Lets you specify call limits, ANI prefixes, as well as a tariff and markups to 
apply to incoming calls.

c. VPN – Same as outgoing, but also lets you specify RNX number ranges for on-net calls, 
as well as a separate set of tariffs and markups for on-net vs. off-net calls.

7. Tariffs – Tariffs determine how to rate the calls and what call type to assign to them. There are 
several different tariff types:

a. Cost Band – Applies rates based on "bands" of areas defined by dialing prefixes. Can 
also be used for local/national/international call determination.

b. Simple Duration – Applies a simple rate based on the call duration (i.e. $0.10 for the 
first minute, $0.05 for each additional minute).

c. Flat Rate – Applies a flat rate per call (i.e. $0.50 for 411 calls).
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d. Mileage Band – Applies rates based on estimated distance (distance calculated using 

V&H coordinates for NANP area codes and exchanges). Different bands can be set up for 
inter vs. intra state and inter vs. intra LATA.

e. WATS Step Rate – Applies rates based on time steps (i.e. the first 100 minutes each 
month cost X, the next 1000 minutes cost Y).

f. Meter Pulse – Applies a fixed cost per meter pulse (the number of pulses must be 
picked up from the CDR).

8. Tariff Call Types – The default call types are sufficient for most customers, but some customers 
need to create their own for specific reasons.

9. Custom Locations – TeleMate contains over 120,000 locations in its city table, but most of those 
are in the NANP (US, Canada, and Caribbean). If you have a list of more specific locations you 
want to show up for calls in the TeleMate reports, you may enter them.

10. Destination Categories – If you have specific destination phone numbers that appear in your 
logs on a regular basis, you can use this feature to categorize them. For instance, if some of your 
employees make a lot of personal calls to friends and family, you can categorize those numbers 
to make them stand out on a report, or so you can filter them in or out of a report.

11. Taxes – Taxes do not affect call processing, but they can be assigned to costing methods, which 
can affect the output of certain reports.

Note: The CDR Layout Test takes all of these configuration options into account (except for destination 
categories and taxes) when it shows you how a call is processed. If your first CDR Layout Test seems to 
parse the CDR records correctly, but the processed phone number, location, cost, or call type is not 
coming out the way you want, you can reconfigure some of the options above and run the test again. If 
you need help, please contact TeleMate Technical Support at 678-589-7120.

Processing Calls Manually
When everything looks accurate in your CDR Layout Test, you are ready to process calls:

1. Open the Voice component and select the correct data source.
2. Open the “Data Source” menu, select “Processing”, and then “Process New Data”.
3. The TeleMate Service Manager window should open and show you messages and statistics as 

the processing operation runs.
4. If the operation completes without errors, all unprocessed CDR logs have been processed.
5. If you encounter any errors, please contact TeleMate Technical Support at 678-589-7120.

Reprocessing Calls
If a mistake was made in the CDR Layout or costing configuration, calls may be reprocessed. If the 
configuration changes you made after processing calls only affect the phone number, location, call type, 
and call cost, then you should open the “DataSource” menu, select “Processing”, and then select 
“Recost Processed Data”. If you had to change your CDR layout, or changed rules on which calls to drop 
in “Custom Call Processing”, then you need to select “Reprocess Raw Data” from the same menu. Both 
will ask you for a date range, but they do very different things. The recost operation loads processed call 
records from the database, runs them through the costing engine, and saves the changes back to the 
database. The reprocess operation deletes all processed calls for the specified date range and then scans 
all CDR log files it can find, then processing all call records it finds in that date range. If you have moved 
any of your CDR log files so that TeleMate can’t find it, this will cause you to lose call data!

Automating Data Source Operations
Now that your CDR log files are being collected and TeleMate has been configured to process them, we 
recommend that you schedule certain operations to run automatically. Collection (for some collection 
methods), processing, and purge operations can all be scheduled for each data source. The EZ Scheduled 
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Event Wizard will automatically appear after you configure a data source, and it will continue to appear 
when you open the data source until you either complete the wizard or check the "do not show" check 
box on the wizard's first screen.

The EZ Scheduled Event Wizard
1. From the EZ Scheduled Event Wizard's main screen, select "Don't show this wizard again for this 

data source" check box if you do not want TeleMate to automatically engage the scheduled 
event wizard in the future.  You can, however, manually choose to start the wizard yourself by 
selecting the EZ Scheduled Event Wizard from the Data Source menu at any time.

2. Select an activity or activities you would like to schedule.  You can choose one activity or all of 
them from the check boxes provided.  Additional screens will be added to the wizard, depending 
upon the activities you select.

Manually Scheduling Operations
Instead of using the wizard, you may prefer to schedule operations manually. To do that, select the 
Scheduler component from either the “Go” toolbar or the “Go” menu.

Real-Time Processing
If your CDR log records are collected using a real-time or near real-time method, we recommend that 
you enable real-time processing instead of scheduling it. If you have alarms set up, they will be sent 
much more quickly, and the real-time call monitors included with the TeleMate web interface will 
always be up-to-date.

Real-time processing looks for new CDR records to process once per second, and it is more efficient than 
scheduling a processing operation to run every few minutes. To enable real-time processing, open the 
“DataSource” menu, select “Processing”, and then select “Enable Realtime Processing”. You may enable 
real-time processing for as many data sources as you want. They will all run simultaneously, and several 
processing tables will be cached in memory (making it much more efficient to use real-time processing).

Note: Because real-time processing caches several processing tables in memory, certain configuration 
changes will not be noticed by the processing engine until it is restarted (which occurs every night at 
midnight). Operations like CDR Layout Test and Costing Test run in a separate process, so they always 
load the tables and use the latest configuration. However, if you’re using real-time processing, we 
recommend that you force the processing tables to reload after you finish making configuration 
changes. To do this, open the “DataSource” menu, select “Processing”, and then select “Reload 
Processing Tables”.

The Directory Component
When you process CDR logs into TeleMate, it will create a table of extensions (or source phone 
numbers) and DISA numbers (or authorization codes). Together these identifiers of call ownership are 
known as “addresses” in TeleMate. (If you choose to process non-call information into TeleMate, those 
addresses could also be email addresses, IP addresses, account names, etc.) The primary purpose of the 
Directory component is to allow you to assign these addresses to users in a directory tree with 4 levels: 
company, division, department, and user. The names of these levels can be changed, and you can use 
them for to group calls in any way you wish.
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The only restriction to what you use each level for is that certain advanced features are tied to specific 
levels, and if you need those features, they may dictate what you use each level for. To rename the 
levels, open the “Tools” menu and select “Custom Field Names”. If you change the names of these 
levels, those names will be updated everywhere in TeleMate (i.e. menus, report names, filter names, 
text generated inside the reports) to match your organization. However, in documentation the levels 
will always be referred to using their original names.

Getting Started
The directory component provides a few methods to manage addresses, but the primary method is with 
the “Organization” tree. You can right-click on any element in the tree to manage that element, or to 
create new elements at the same level or beneath it. You can also select “Add” from the Directory 
menu, but since you have to select an element before you can add a new element beneath it, it is easier 
to right-click. Most elements can also be transferred, modified, or deleted by right-clicking on them, and 
click+drag can also be used to transfer elements between one parent and another.

The first time you open the directory component, there will be one company named “!Unassigned” that 
all addresses created by the processing engine belong to. To make reports more meaningful, Calls 
belonging to unassigned addresses are excluded from many reports by default, so we recommend that 
you create your own directory tree and start assigning addresses to users. Even if you do not wish to use 
all the levels of the TeleMate directory, you must create at least one element at each level before you 
can assign addresses to users. If you only create one element at a level, then there is nothing to choose 
from at that level, which in the end is the same as not using it.
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Note: Creating new directory elements, modifying them, and transferring them between parent 
elements is easy. However, deleting elements can be complicated once they have data assigned to 
them. TeleMate has advanced features to track historical changes, assign expense codes and 
distributions to users, and even to generate invoices, which makes deletion even more complicated. If 
you’re using those advanced features, often the best thing to do is transfer an unwanted element to the 
“!Unassigned” bin.

Directory Element Options
The only required field when creating a new directory element is a name. All other fields are optional, 
and depend on whether or not you plan to use some of TeleMate’s more advanced features:

Options available at all levels

• Description – Unless you use this in a custom report, this field is informational only
• Email – This field is used for “Email Breakout” report distribution. For example, at the 

department level you could specify the email address of each department head. Then you could 
run a system-wide report using “Email Breakout” at the department level, and every 
department head would receive an email of that report for his department.

• History (only if historical tracking is enabled) – This tab lets you view and modify historical 
changes per element, such as when user A was transferred from department X to department Y. 
It affects when that user (and the calls assigned to it) will show up under which department, so 
it can have a profound impact on organizational reports.

Options available at the Department level

• Cost Adjustments – These fields allow you to markup calls based on which department they 
belong to at the time they are processed

• Costing Method – Instead of just applying markups, you can apply a completely different costing 
method for outgoing calls (and assign taxes to go along with it). This option is for customers who 
need to rate calls based on organization, and it causes calls to be rated twice (which allows for a 
Profit & Loss report if you use TeleMate for billing purposes). The tax assignments will only be 
used in custom reports, so they can mean whatever you want them to mean.

Options available at the User level

• User type – Person, overhead, or miscellaneous (this field is informational only)
• Workgroup and title – Primarily informational, but can also be used as report filters
• Street Address – Used on bill reports, but otherwise informational only
• Additional Devices – Additional devices like pagers (informational only)
• User Data – Unless you use them in a custom report, these fields are informational only

Importing Directory Elements
TeleMate provides three methods for importing directory elements: importing a delimited file, 
importing from Unimax’s 2nd Nature PBX management software, and importing from an LDAP directory 
(i.e. Active Directory, eDirectory, OpenLDAP).

Note: Even though directory elements are not tied to data sources, the addresses assigned to them are. 
So each import must be tied to a data source so that when it assigns an address to a user, it knows 
which data source to get that address from.

Copyright © 2010 TeleMate.Net Software. All rights reserved. Page 20



TeleMate.Net Software – TeleMate First Steps Guide
Delimited File Imports
If you can export your directory information from a database or spreadsheet to a delimited file, like a 
CSV or tab-delimited file, you can import it into TeleMate. For each file you need to import, TeleMate 
allows you to specify the delimiter, the number of header rows to skip over, and which delimited fields 
to import into which directory fields. Once you have configured an import template, you can schedule it 
to automatically keep the TeleMate directory in sync with whatever product you currently use to 
manage your company’s directory (assuming you can schedule an export from that product).

To set up a delimited file import, open the “Directory” menu, select “Import”, and then select “Generic 
Directory File”. Select the “Add” button to create a new import template. Select a data source, enter a 
name for this template, and specify the path to the delimited file you wish to import. If you have not 
created the delimited file yet, you must do so before you can continue. The next page will show you the 
first few lines from the file and ask you to specify the delimiter and the row number to start importing 
from. The next page will parse the delimited fields from a few rows based on those selections. To assign 
delimited fields to TeleMate fields, drag the TeleMate field names from the list above and drop them 
onto the delimited fields below.

Unimax 2nd Nature Imports
This option is only available if you are licensed for the TeleMate 2nd Nature integration. 2nd Nature 
usually only contains a mapping between user name and extension, so it does not allow you to import 
all of the TeleMate directory fields. Because of the way 2nd Nature manages PBX’s, you must configure 
this import in the Voice component instead of the Directory component.

To get started, open the Voice component and select the data source you want to import. When you 
open the data source property sheet (via the “Properties” button on the toolbar or on the DataSource 
menu), there will be a “2nd Nature” property page available if you are licensed for the integration. On 
that page, enter the 2nd Nature data directory (i.e. C:\2NData). If 2nd Nature is detected properly, you will 
be provided with a list of 2nd Nature phone systems to choose from. Select the phone system and press 
“Run Import Now”. That will update a 2nd Nature configuration file to tell 2nd Nature to export its 
directory into a text file that TeleMate can read, and TeleMate will import the file.

LDAP Imports
This import option is only available in the Collector Pro and in the TeleMate web interface. The Collector 
Pro will import the data to a delimited file, which you can then import into TeleMate. The web interface 
will import the directory information directly into TeleMate. Here is a brief outline of what you need to 
set up an LDAP import in the web interface:

1) Connection Options – First you must specify the data source, connect type, LDAP server, LDAP 
port, login, password, and root DN. An optional user search filter is available.

2) Organizational Units – Next you must specify which OU’s under the root DN to import (and 
specify a default department for each OU to be imported into). If you don’t, no users will be 
imported.

3) Groups – Next you may optionally specify user groups to import (and specify a default 
department for each group to be imported into). This is only required if you did not select any 
OU’s to import. If you import OU’s and groups, there may be a conflict over which department 
to put a user in. In those cases, the group assignment will override the OU assignment.
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4) Attributes – Next you must map TeleMate fields to LDAP attributes. Some common mappings 

are Last Name = sn, First Name = givenname and Email Breakout = mail. If you pick up company, 
division, or department from the attributes, it will override the OU and group selections.

5) Exceptions – If a few users get put in the wrong company/division/department no matter how 
you configure the import, you can either make changes in your LDAP directory or add them as 
exceptions to force them into the correct TeleMate department in TeleMate.

Note: Very few of our customers have a simple way to import their extension numbers from their LDAP 
directory. In many cases the information simply does not exist in LDAP. In other cases external phone 
numbers are entered in LDAP and need a custom conversion routine written to map them to internal 
extensions. Having multiple data sources makes it much more complex. It can be done, but it usually 
requires a developer, which would require you to pay for professional services.

Historical Tracking
Without historical tracking, if you transfer a user to a new department and then run a report for his old 
department from last year (or last month), that user and all of his calls will have vanished from that 
department because that user’s link to the old department is gone.

With historical tracking, all transfers at all levels in the directory are kept with a date associated with 
them. This means that if you transfer a user to a new department on April 16th, when you run a report 
for April, the old department will show that user and all of his calls from the 1st to the 15th and the new 
department will show that user and all of his calls from the 16th to the 30th. You may even set up 
transfers to occur at a specific date in the past or future, and any reports you run will automatically take 
it into account.

Historical tracking can be enabled or disabled by opening the “Tools” menu and selecting “Options”. 
When enabled, additional options will be available in the directory component. In addition to being 
asked for more information when transferring or terminating, you will be able to set the effective date 
for your view of the organization. It defaults to showing you the organization for today, but you can 
change it to show you what the organization looked like 3 months ago, or even a year ago.

Note: Enabling historical tracking makes maintaining your directory more complex. Every time you run 
an import or transfer directory elements, you will be asked for an effective date for the transfers to take 
place. TeleMate will not allow you delete anything with historical data tied to it, so if you really want to 
delete a directory element, you may have to go back and “change history” to remove past data assigned 
to it. Otherwise, you will be asked to “terminate” that element instead (which transfers them to the !
Unassigned bin on the effective date). Because it is difficult to delete mistakes, an import that goes 
wrong can cause some major headaches.

Important: If you plan to enable historical tracking, we strongly recommend that you leave it disabled 
until you have your initial directory set up exactly the way you want it, and that you back up your 
database right before you enable it. After you enable it, use a scheduled import you trust to handle 
updates or run a few tests and come up with a set of procedures to handle manual moves, adds, and 
changes.

Critical: Once it is enabled, disabling historical tracking will delete ALL historical links. While this is useful 
if you make mistakes when you’re getting started, it could be a nightmare if you do it without meaning 
to after building up a year or more of historical links.
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Dangerous Delete Operations
Sometimes our customers really need to delete directory elements completely without any concern for 
the data assigned to it. For that reason, we have provided a few features that are somewhat 
“dangerous”, but may be the best way to clean up a directory with a lot of problems.

If you right-click on a company element and select “Delete Organization”, it will delete that company 
regardless of any data assigned to it. Any elements beneath it that have always been assigned to that 
company will also be deleted completely. Any elements that have been assigned to other companies at 
any point in time will NOT be deleted. Instead, the time they spent in the deleted company will be 
transferred to the !Unassigned bin. That allows TeleMate to completely destroy the selected company 
without affecting any other companies in the directory, which makes this operation relatively safe 
(assuming you really want its directory elements gone).

If you right-click on the !Unassigned bin and select “Cleanup !Unassigned bin”, it will completely destroy 
every directory element currently in it. Addresses are not directory elements, so they will stay in there. 
However, if you transfer a department to the !Unassigned bin effective today and then clean it up, that 
department and every user under it will be ripped out of history. This operation will affect other 
companies, which makes it very unsafe.

Searching for Directory Elements
Sometimes elements may be hard to find if you have a large directory. In addition, it is possible to lose 
elements in time when you have historical tracking enabled. Directory elements that exist under a 
certain department a month ago may seem to be missing now (which generally means they’re in the !
Unassigned bin). If you are having trouble finding a directory element, you should select the “Find” tab 
and search for it. This allows you to quickly find divisions, departments, names, or addresses no matter 
where they are. Once you find it, you can double-click on it to find out where it is in the directory tree, 
and you can transfer it if necessary. If history is enabled, we recommend that you open its properties 
and look at its history tab before you transfer it. Instead of transferring it, you may need to modify the 
historical links (i.e. if a user was transferred from the Sales department to !Unassigned by accident, you 
can delete the transfer to !Unassigned, and it will put him back in Sales).

Expenses
TeleMate’s expense features are advanced and only provided to customers who purchase an Enterprise 
license. They allow you to assign both call-related costs and non call-related costs (i.e. one-time or 
recurring) to users. You can assign taxes to expense codes and use the combination of calls and 
expenses to generate invoices and/or bills.

Expense Categories and Codes
The first step is to create some expense categories and codes. Open the “Directory” menu, select 
“Expenses”, and select “Categories”. Start by adding a new category, and then adding a new code under 
that category. There are several expense code types:

• Period – Use for non call-related one-time and recurring expenses, like installation fees and 
monthly service charges. Recurring expenses will be pro-rated for partial periods.
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• Assigned Users – A single large expense amount will be distributed equally across all assigned 

users over the specified date range.
• Call Count – A single large expense amount will be distributed across all assigned users, 

weighted by the total number of calls made by each user, over the specified date range.
• Call Duration – A single large expense amount will be distributed across all assigned users, 

weighted by the total call duration made by each user, over the specified date range.
• Invoice Calls – This type was created for our new invoicing feature, but it can be used for normal 

expense distributions. It applies an expense amount based on a percentage of total call cost for 
specific call types. One example of when you may wish to use this is when you need to apply 
state sales tax to intrastate calls but not interstate or international calls. (You can set up 
separate expense categories and codes for different states to apply different tax rates to 
customers in different states.) Another example would be to calculate a federal or local 
Universal Service Fee (USF), which may also need to have taxes applied to it.

Note: Some reports that show distributed expense amounts add call costs and distributed costs 
together for user billing. The new invoice reports expect you to use “Invoice Calls” expense coded to 
group different call types into different line items on the summary page, and so you can specify which 
line items have which taxes applied to them.

Assigning Expense Codes to Users
Once you have expense codes set up, you must assign them to users or they will not be used. All 
expense code assignments require a quantity (which defaults to 1), a start date, and an end date (which 
is ignored for non-recurring period codes).

When you first set up an expense code, a button that looks like an organizational tree exists on the 
expense code window that will let you assign the new expense code to an entire division or department. 
When you assign an expense code from this window, it will only ask you for a quantity and a start date. 
The end date is assumed to be the “end of time”, which means that recurring expense codes will never 
stop being applied unless you terminate the assignment for a user at a later date.

To manage expense code assignments one user at a time, find and select that user in the organization 
tree. Once you’ve done that, a new “Expenses” tab should appear in the right-hand pane of the 
Directory component. When you select it, you will see a tree of expense categories and codes, with 
checkboxes next to each that show which expense codes are assigned to that user as of the effective 
date (which defaults to today but can be changed if historical tracking is enabled) and to allow you to 
add/remove assignments. You can also right-click on the tree and select “Expense History” to view and 
add/edit/delete assignments more precisely.

Note: Expense code assignments always track changes historically regardless of whether historical 
tracking is enabled for directory transfers.

Expense Periods and Distributions
Once you have expense codes assigned to users, you need to distribute the expense amounts by 
creating expense periods and distributions. Prior to release 6.0, you had to open the “Directory” menu, 
select “Expenses”, select “Distributions”, and then manually create each period and distribution to run. 
After running a distribution, you could report on it. However, in 6.0 most of the Expense reports provide 
an option to create and run a distribution when the report runs. By scheduling these reports, you can 
schedule your distributions.
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Note: The “Invoice Batch” report can generate both an expense distribution and an invoice batch.

Invoicing
Starting with release 6.0, TeleMate includes invoicing features. These features are advanced and tied to 
expenses, so they are only provided to customers who purchase an Enterprise license. The invoicing 
features revolve around running “batches” of invoices. Individual invoices are always generated at the 
user level, but batches can be run at any level in the directory from global all the way down to running a 
batch for one user.

Running a batch does several things:
1) It generates unique invoice numbers for every user included at the specified directory level.
2) If you assigned a costing method with a WATS Step Rate tariff to a department, it will recost 

calls for the affected users for the specified date range to ensure that the call costs are correct.
3) It generates an expense period for the selected directory entity.
4) It generates and runs an expense distribution for the specified date range.
5) Unless this is just a test batch, it assigns all affected calls and distributed expense amounts to 

the correct invoice numbers, which locks those records so that you can’t delete or modify them. 
(Once you mail an invoice out, the data is set in stone to ensure that you always have a record of 
what you sent your customers/clients.)

The recommended procedure for running invoice batches is to let the “Invoice Batch” report run it for 
you (or some custom report based on the “Invoice Batch” report). The “Invoice Batch” report allows you 
to run test batches, which is a great way to let you review everything before the final batch is run. This 
allows you to fix any problems you find in the invoices before the records are locked and unable to be 
modified. If necessary, you may also right-click on any level in the Organization tree and select 
“Generate Invoices…” To create global batches or view/delete existing batches, open the “Directory” 
menu and select “Invoice Batches…”

To keep the list of batches from growing to a size that is difficult to manage, we recommend that you 
run it at the highest directory level possible to avoid having hundreds of little batches to manage. For 
instance, if you have one company with 10 divisions under it and 10 departments under each division, 
running batches at the department level would create 100 batches per billing period. Running them at 
the division level would create 10, and running them at the company level would create 1. So run 
batches at the company level unless you have valid business reasons to do otherwise (i.e. different 
divisions have different billing periods or have different deadlines for generating and mailing out 
invoices).

If necessary, individual invoices can be deleted so you can modify them and run a smaller batch, and 
adjustments (i.e. credits/debits) can be assigned to a user to be included in the next invoice. 
Adjustments must be assigned to specific expense codes so that the proper tax amounts can be applied 
to them.

The Report Component
The report component is where you run one-time (or ad-hoc) reports, save report filters and options to 
make them easilyer to run them quickly in the future, and schedule them to run automatically. If you 
have already set up at least one data source and a directory, we recommend that you run some reports 
to make sure the processed data looks correct before you continue setting up TeleMate.
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The Report Views
There are three main report views: Category, Alphabetical, and Stored.

The Category view lets you find reports based on what type of information it presents. For instance, all 
“Call Accounting” reports under the “Activity by Department” category will group data by department. 
For instance, the “Call Activity Overview by Department” report will show you one page per department 
with a line chart of call counts by day of week and a pie chart of call counts by call type group. If you find 
and run the same report by user, the report will show you one page per user.

The Alphabetical view lets you find reports by name. This is useful if you know the name of the report 
you want to run but do not remember which category it is in.

The Stored view only lists your “stored reports”, which are essentially sets of filters and options you 
have chosen to save and/or schedule. We recommend that you save a set of common options for any 
report you like to run often. You can give the stored report any name you wish, which makes it very easy 
to find in the Stored view.

Report Preview
As we mentioned above, the report preview helps you learn what information is displayed in each 
report. If you’re not sure which report(s) to run, click through the report tree with the Preview tab 
active.
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Running a Report to Screen
When you find a report you’d like to run against your data, double-click on it in the report tree or select 
the “Properties” tab to specify a date range to run it for. A selection list lets you choose from some 
simple options like “Yesterday”, “Last Week”, or “Last Month”, but you may also select “Specify a Date 
Range” to enter your own start and end dates. You may also set up filters to view a more specific set of 
data, and you may select the “Options” tab to see what advanced options are available for that report.

When you’re ready, select “Run to Screen”. If the report viewer shows this message: “WARNING: No 
data was found for this report”, clear any filters you’ve specified and try expanding the date selection. If 
all else fails, set the date selection to “All Dates”. If it still shows that message, then you need to make 
sure your data processed correctly. If the report is based on the directory organization (i.e. by 
department or user), make sure that you have extensions assigned to users in the directory (i.e. not in 
the !Unassigned bin).

The Report Viewer
When you use “Run to Screen”, the report will be displayed in the TeleMate Report Viewer. This 
viewer’s main purpose is to let you quickly review a report to make sure it looks ok before distributing it 
to disk, email, printer, etc. As a result, it has basic paging, scrolling, zoom, search, export, and print 
options. It was never meant to duplicate advanced features in Acrobat, Word, Excel, etc. If you want 
those advanced features, export the report to a specific file format and open it in that viewer.

Running a Report to Destination
Select “Run to Destination” when you want to send a report directly to a file, email, printer, etc. The 
distribution options are at the top of the “Properties” tab.

One important difference between running a report to screen and running it directly to a destination is 
that the report viewer must keep every page it generates in memory while the background engine will 
stream the pages to disk or printer. For extremely large reports, the viewer may run out of memory if 
you try to skip to the last page or export it to disk/printer. However, using “Run to Destination” or 
scheduling a report should not run out of memory no matter how large the report is.

Saving/Scheduling a Report
When you’ve finished configuring a report’s options and you like the way it looks, you can save those 
options to a “stored report”. You can give this stored report any name you wish, and you can schedule 
stored reports either from the report component or from the scheduler component.

To save a report, select the “Save As” button on the Properties/Options tab. You will be asked for a 
name and whether you want to save without scheduling or to schedule it using one of the most popular 
scheduling options: daily, weekly, monthly, week-to-date, or month-to-date. Once you save it, you can 
right-click on the stored report and select “Add/Delete Schedule Activity” if you change your mind. 
When you right-click on it, note that you can also delete it, run it once, queue it to run in the 
background, or reuse the stored settings (which copies the settings so you can make minor changes and 
either run once or use “Save As” again).
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The Scheduler Component
While other components include features that make it easy for you schedule certain operations, the 
scheduler component ties all the scheduled events together and provides more advanced options. 

Basic Options
The main view shows you scheduled events and activities in the left pane, and a list of recent scheduled 
runs for the selected event or activity in the right pane. By right-clicking on items in the left pane, you 
can add, delete, or modify events. One thing you can do from the scheduler component that you can’t 
do from other components is assign several activities to one event. Instead of creating 10 scheduled 
events for 10 stored reports, you can create 1 monthly event and assign 10 stored reports to it. You can 
also choose to schedule daily collection, import, processing, purge, and reporting activities all in one 
event. Or you can create an event that runs every day, but only during the month of March 2010.

On the other hand, the additional options make it easier to make mistakes. For instance, if you create a 
monthly event and assign a daily stored report to it, once a month you will receive a report that includes 
only one day of data, which most people would not consider very useful. You can also choose to run a 
report every 10 minutes that includes “yesterday”, which would give you the same output every time it 
ran.
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Special Options
You can also set up special options such as email notification when a scheduled event completes 
successfully or custom batch activities that let you run any command you can run from the command-
line. You can also change the priority of different activities to make sure activity X runs before activity Y.

The Alarms Component
The alarms component is licensed separately from the rest of TeleMate, so it will only be available if it 
was included in your purchase agreement. Alarms are generated when calls are processed, so real-time 
processing is important when it comes to receiving alerts in a timely fashion. When you create an alarm, 
you must specify a set of filters (very much like the filters for a report). Next you must specify a set of 
time periods to monitor calls for those alarms (with thresholds set for each time period). There are two 
types of alarms in TeleMate: emergency alarms and threshold alarms.

Emergency Alarms
These alarms are generated for individual calls, like a 911 call. Because they are generated from a single 
call, they can be tied back to a user in your directory. This allows TeleMate to include additional 
information to the alert email. It also allows the alert email to be sent to the email address entered for 
that user’s department, division, and/or company in the directory.
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Threshold Alarms
These alarms are generated when a certain group of calls (defined by the filter values entered) exceeds 
a certain call count, duration, or cost threshold. Because these alarms are generated for a group of calls, 
specific call information is not available, so fewer options are available for distributing alert emails.

A good example of a threshold alarm would be if you want to be alerted when there is a spike in the 
number of international calls, or for any long distance calls when the total cost gets too high. In this 
case, you may want to break the alarm periods up into different days of the week, and even different 
times of day. For instance, you may want to allow a certain count/duration/cost for international calls 
during normal business hours, but to alert every time an international call is made outside of normal 
business hours.

The User Manager Component
The user manager allows you to choose which Windows accounts (whether local or domain accounts) 
have which privileges when running TeleMate. If an account is not listed in TeleMate’s user manager, 
that account will not be allowed to run TeleMate at all. The Windows account that runs TeleMate for 
the first time will automatically be assigned to the Administrator group, but all other Windows accounts 
must be added manually and assigned to a specific group.
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Managing Groups
Right-click on a group and select “Group Properties…” to see all the privileges you can add or remove 
from various groups. You can also add, edit, and delete groups (except for the Administrator group). 
When editing a group’s properties, you will see that you can add/remove privileges to access specific 
datasources, user interface features, reports, and departments (if you check “Use Organizational 
Security” for the group). If a group does not have access to a specific datasource or department, all 
queries run both in the product and in the reports will automatically filter it out.

Managing Users
You can do the same thing with users, including overriding group privileges for a specific user. However, 
if you do start using user-level privileges, you should keep in mind that the next time you change a group 
privilege, it may override user-level privileges you have set.
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The TeleMate Web Interface
TeleMate’s web interface allows TeleMate administrators to access TeleMate reports, directory, and 
real-time call monitors from anywhere on the network without having to install a client. Administrators 
can also grant access to managers and other employees in the organization who need to be able to 
access that information. The web interface must be licensed separately from the main product, but you 
may evaluate it for free for up to 15 days after installing the product.

The web interface also provides some features that are not available in the main TeleMate product. 
LDAP imports allow you to import your organization into TeleMate's directory using LDAP (i.e. Active 
Directory, eDirectory). Real-time call monitors allow you to watch calls in real-time on graphs as soon as 
they are logged by your phone system, and to give email alerts when certain thresholds are exceeded. 
The graphs are updated every 15 seconds, but new data is processed and alerts may be generated every 
second (depending on how quickly you can collect CDR data).

Starting the Web Server
TeleMate's web server runs as a Windows service, so it is managed in the TeleMate service manager. To 
start it from TeleMate, select "Service Manager" under the "Tools" menu. Select the "Web Server" 
service, change any options you'd like to change, press "Apply", and start the service. It should look 
something like this:

Logging into the Web Interface
Once you have the web server service running, press the "Browse" button in the service manager to 
open your default web browser and point it to the correct web page. You will be asked to log in. If the 
authentication method you chose was "TeleMate Login", then your password will be blank the first time 
you login. You may change it from within the web interface or from the user manager component. If you 
chose "LDAP Login", then your password will be sent to your LDAP server (i.e. domain controller) for 
authentication, allowing you to use Windows domain passwords, which keeps you from having to 
manage a separate password in TeleMate.
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Warning: TeleMate requires HTTPS for LDAP authentication to avoid sending your domain password 
across the network without encrypting it. However, if your domain controller is not using secure LDAP 
(LDAPS), the LDAP protocol will transmit domain passwords in clear text. If there is a chance someone 
may be able to intercept packets between your TeleMate server and your LDAP server, make sure the 
LDAP server is configured to use LDAPS.

Using the Web Interface
The web interface contains a lot of functionality in a few pages, but we tried to make it as simple and 
intuitive to use as possible. In addition, the TeleMate administrator has fine control over group and user 
privileges in TeleMate's "User Manager" component, allowing control over what each login is allowed to 
access in the web interface. In addition, the administrator can see and edit reports set up by other web 
users.

Using the screenshot below as a guide, the links in the sidebar are for:
• License: Shows the product version and license information.
• Monitors: Select to manage/view the real-time call monitors.
• Create Report: Select to run a one-time report or schedule a recurring report.
• Scheduled Reports: Select to manage your scheduled reports.
• Pending Reports: When you run a report, it gets queued. Here you can see where your reports 

are in the queue if they don't finish quickly.
• Completed Reports: All reports run/scheduled from the web interface are archived in folders on 

the server, and they can be viewed here when they have completed. (Reports can also be 
distributed to email and printer.)

• Manage Organization: The entire TeleMate directory can be viewed/managed here.
• Manage Expenses: (Only available with an Enterprise license) All of TeleMate's Expense features 

can viewed/managed here.
• Define Import Template: Allows you to manage and schedule directory imports from a 

delimited file or from an LDAP server.

Copyright © 2010 TeleMate.Net Software. All rights reserved. Page 33



TeleMate.Net Software – TeleMate First Steps Guide

Web Browser Support
The TeleMate web interface has been tested primarily on Firefox 3.0 and Microsoft Internet Explorer 6.0 
and 7.0. All functionality works in IE 6.0 except the real-time call monitors, which use graphing functions 
that are not available in IE until version 7.0. Everything seems to work fine in the latest versions of 
Firefox, Opera, and Google's Chrome web browsers. Other web browsers have not been tested at all by 
TeleMate's Q/A department.

NOTE: Browser security settings can affect features in TeleMate's web interface. A lot of features will 
not work when browsing with IE in Server 2003 or Server 2008 until you add the web site to your list of 
"Trusted" sites. Other users may have similar problems depending on the security restrictions enforced 
by your IT department.

Updating the HTTPS Certificate
We have created a self-signed certificate for customers who wish to secure the TeleMate web site via 
HTTPS. This works, but most web browsers will give end users warnings when they try to visit the site 
because the certificate was not signed by a recognized Certificate Authority (CA), and because the web 
site name in the certificate does not match your web site name. If you wish to update the certificate the 
web server uses, you must do these things:

• Choose a full DNS name for your web site (i.e. telemate.mycompany.com). It should be a sub-
domain of a domain you own.

• Make sure your company's internal DNS server resolves that name to the correct internal IP 
address. (If you wish to allow Internet access, you must also set up an external DNS entry to 
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point to your firewall and configure your firewall to forward the right traffic to the TeleMate 
web server.)

• Contact a recognized CA, like VeriSign, and purchase an HTTPS certificate for the full DNS name 
you chose in step 1. (If the DNS name on the certificate doesn't fully match the site name used 
in the browser, users will continue to get that warning.)

• Look in "C:\TeleMate Software\WebApp" (assuming you installed TeleMate to "C:\TeleMate 
Software"). Replace the server.cert and server.key files with files supplied by your CA.
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